An Introduction to Reference Management and Plagiarism Checker
## Contents

Acknowledgements ......................................................... vi
Overview of the Manual .................................................. vii

**Section One** ...........................................................................
1.0 An introduction to Mendeley ........................................... 1
1.1 An Overview of Mendeley ................................................ 1
1.2 Setting up Mendeley on a Computer System ...................... 1
1.3 The Mendeley Interface .................................................. 2
1.4 Building a Mendeley Library ........................................... 4
1.5 Create citations in Microsoft Word using Mendeley ............. 5
1.6 Changing bibliographic output style in Mendeley ............... 7
1.7 Adding the University of Ibadan Manual of Style to Mendeley (UIMS) .................................................. 7

**Section Two** ...........................................................................
2.0 Searching Online Academic Databases .............................. 12
2.1 What is an online academic database? ............................... 12
2.2 Using controlled language to search online academic databases .................................................. 14
2.3 Features of online academic databases .............................. 16
2.4 Searching an online academic database ............................. 16

**Section Three** ........................................................................
3.0 An introduction to Turnitin ............................................ 21
3.1 An overview of Turnitin ................................................ 21
3.2 Instructors’ settings ....................................................... 21
3.2.1 Creating a class .................................................... 21
3.2.2 Adding assignments to your class ............................... 22
3.2.3 Adding students to a class ...................................... 24
3.2.4 Viewing Students’ submission 25
3.3 Students’ Instructions 25
3.3.1 Joining a class and setting up a student account 25
3.3.2 Submitting a paper from your student homepage 26
3.3.3 Viewing the similarity report for your submission 27
3.4 Interpreting a similarity report 27
Appendices 29
Contributors

Akinyinka Omigbodun
CARTA focal person/Professor of Obstetrics and Gynaecology, College of Medicine University of Ibadan.

Jonathan Babalola
Provost, Postgraduate College, University of Ibadan/ Professor of Chemistry, Faculty of Science, University of Ibadan.

Olufunke Fayehun
CARTA co-focal person/Senior Lecturer, Department of Sociology, Faculty of Social Sciences, University of Ibadan.

Oluwaseun Obasola
Senior Librarian, Kenneth Dike Library, University of Ibadan.

Olusegun Thomas
Lecturer, Pharmaceutical Chemistry, Faculty of Pharmacy, University of Ibadan.

Olusoji Adisa
Deputy Director, Training Research and Development Unit, Directorate of Information Technology and Media Services (ITeMS).
Acknowledgements

Special thanks to the Consortium for Advanced Research Training in Africa (CARTA) for funding this publication. CARTA is funded by the DAAD, Carnegie Corporation of New York (Grant No--B 8606.R02), Sida (Grant No: 54100029) and the DELTAS Africa Initiative (Grant No: 107768/Z/15/Z). The DELTAS Africa Initiative is an independent funding scheme of the African Academy of Sciences (AAS)’s Alliance for Accelerating Excellence in Science in Africa (AESA) and supported by the New Partnership for Africa’s Development Planning and Coordinating Agency (NEPAD Agency) with funding from the Wellcome Trust (UK) and the UK government.

The statements made and views expressed are solely the responsibility of the Institution. We acknowledge the support of the management of the University of Ibadan and the Postgraduate College from the period the manuscript was developed to the production stage. Our appreciation also goes to librarians at the University of Ibadan Library System who participated in the CARTA Workshop in 2019 and others who invested time to ensure the manual is published.
An Overview of the Manual

This manual was written to be used by academics, IT specialists, researchers and librarians to train all graduate students at the University of Ibadan in three areas namely: online literature searching, reference management and the use of Turnitin to assess plagiarism.

The manual has three sections. The first section is an introduction to Mendeley. The main objective of this section is to teach students how to build a Mendeley library and cite while writing. The second section focused on literature searching using online academic databases and how to assess results from database searches.

The last section will help users of the manual to make submissions to Turnitin, understand and interpret reports generated from the web-based resource. Each section has exercises to deepen users’ knowledge of the three highlighted areas.

To use the manual, users will require a computer system with Internet access, Mendeley installation on the computer system and access to the Turnitin web portal.

The manual is intended to provide a brief introduction to the use of Mendeley, Turnitin and online literature searching. It should not be regarded as exhaustive.
Section One

1.0 An Introduction to Mendeley
The objective of this section is to teach users of this manual how to:
• set up Mendeley on a computer system;
• build a Mendeley library;
• create citations in Microsoft Word using Mendeley; and
• change bibliographic output style in Mendeley.

1.1 An Overview of Mendeley
Mendeley is a reference management software owned by Elsevier, a renowned publishing company. It is a free web-based resource that allows users to:
• store all the references downloaded from the Internet during research work;
• import citations from online academic databases;
• store PDF (Portable Document Format) files, pictures, graphs, tables, etc.;
• add citations to a term paper, report, journal manuscripts etc.;
• create bibliographies in any output style;
• highlight papers and share those comments/notes with others; and
• it can also serve as an alternative search engine to Research Gate, Google Scholar, Web of Science and Scopus.

Mendeley has a desktop version and an online version that synchronizes users’ literature searches from all over the world and on any device while ensuring the library is continually updated. The three versions of the reference management software are Mendeley: Web, Desktop and Mobile. This manual will focus on Mendeley Desktop.

Note: Mendeley is preferred to Zotero because of its user-friendly nature and features.

1.2 Setting up Mendeley on a Computer System

1. To install Mendeley on a computer system, it is important to first set up an account on the Mendeley website. Visit https://www.mendeley.com/ to create your Mendeley account.
2. After creating a Mendeley account you should be able to download Mendeley Desktop or visit http://www.mendeley.com/download-mendeley-desktop/ and click “Download Mendeley Desktop” for Windows, Mac OS (Operating system) or Linux System (See Diagram 1).
3. Locate the Mendeley installation file in the download folder and double click on it to set up Mendeley on your computer system.

4. After completing the installation, launch the software by double-clicking on the Mendeley icon on the desktop or start-up menu.

The Mendeley interface presented in Diagram 2 will be opened once the reference manager has finished loading.

1.3 The Mendeley Interface

As shown in Diagram 2, Mendeley Desktop has a three-column view. The first column allows users to move through the library, from one folder to the other with many filters. The first column allows users to create custom filters for different folders which will also be listed in this column.

The second column provides a list of references, with their details. Entry details – such as a paper title, author and year of publication - are displayed in column two. For example, using a view filter ‘Unsorted’- selected in column one - only the relevant documents will be displayed in column two.
An Introduction to Reference Management and Plagiarism Checker

i.e. the unsorted entries only. If a user selects ‘All Documents’, the main column, column two will always display all the entries in the library.

The third column displays all the details of the currently selected reference. The third column is used to ensure that a reference’s details have been entered correctly. Clicking on an entry field in the third column allows details of the entry to be modified or edited.

Diagram 2: The Mendeley Interface
1.4 Building a Mendeley Library

Before building a Mendeley library, it is important to install the web importer. The web importer is a feature in Mendeley that imports references from different online academic databases like from Google Scholar, Medline, Web of Science, Scopus etc.

To install the web importer after launching Mendeley, click on ‘Tools’ and select ‘Install Web Importer’ as shown in Diagram 3.

Diagram 3: Installing Web Importer

For more information on how to install the Web Importer when setting up Mendeley on other platforms (like Mac or Linux operating system), See http://www.mendeley.com/download-mendeley-desktop/

Building a Mendeley library requires adding references. There are several ways of adding references to a Mendeley library:

i. An easy way to add a reference (such as a PDF file) to a Mendeley library is to drag and drop it into the main window of the Mendeley interface. To drag and drop previously saved PDF files into a Mendeley library:
   - open the folder containing the files; and
   - drag the pdf file from the folder and drop it into Column two (middle pane) of the Mendeley interface.

ii. Single files can also be added to a Mendeley library using the ‘Add Files’ command, listed under the File menu.
   - Click on the File menu and select the ‘Add Files’ command to browse the computer for a specific file.
   - Add the file to the library by double-clicking on it.

iii. A folder containing multiple PDF files can be added using the ‘Add Folder’ listed under the File menu.
   - Click on the File menu and select the ‘Add Folder’ command to browse the computer for a specific folder.
An Introduction to Reference Management and Plagiarism Checker

- Add files in the folder by selecting the folder then click ‘OK’.

iv. References can also be added manually using the ‘Add Entry Manually’ listed under the File menu. The command opens a window that allows users to type in the reference type, and to input the documents details.

v. The ‘Watch Folder’ command listed under the File menu can be used to build a Mendeley library. The command allows a user to specify a folder on the computer system that will be monitored by Mendeley. When a user downloads a new file into the Watch Folder, the new file (references) will be routinely imported into the Mendeley library.

vi. References can be imported directly from online academic databases. Visit the websites below for more information:

   https://library.itc.utwente.nl/papers/mendeley.pdf
   https://library.technion.ac.il/he/Documents/Mendeley/MENDELEY%20USING%20GUIDE.pdf

vii. References can be added to a Mendeley library by importing entries from other reference managers like Endnote, Zotero, RefWorks and other libraries in .ris or BibTeX formats.

1.5 Create Citations in Microsoft Word using Mendeley

Before using Mendeley to cite while you write in Microsoft Word, ensure the Word Plugin is installed. To install the Word plugin in Mendeley:

- close the Microsoft Word application if it is open; and
- select ‘Tools’ on the Mendeley menu and click on ‘Install MS Word Plugin’ command.

To confirm that MS Word Plugin has been installed:

- launch Microsoft Word;
- select the ‘Reference’ tab; and
- if the plugin is installed, you will see the highlighted icon in Diagram 4.

Diagram 4: The Insert Citation Tab in Microsoft Word

1. To insert citations into a document when writing using Microsoft Word;
- select the reference tab in Microsoft Word;
- click insert citation;
- use the search bar that opens to find the reference type you want to insert into the document.
  You can search for a reference by typing the author’s name or a title into the search bar; and
- insert the reference into the document by clicking OK in the Mendeley search bar.

2. Alternatively from the Word ‘References’ tab:
- click insert citation;
An Introduction to Reference Management and Plagiarism Checker

- on the search bar click the ‘Go to Mendeley’ button;
- select a reference to highlight in the Mendeley library reference list; and
- on the menu bar click the “Cite” button to insert the selected reference in the Word document. See Diagram 5.

Diagram 5: Inserting Citations into a document

2. Adding References to a document

When writing a document using Mendeley, the reference manager will only add the citation without references to the document. To add the list of references to a document:

- position the cursor in the Word document at the exact location where the reference list should appear;
- click on ‘Insert Bibliography’ on the ‘References’ tab. The reference list will be displayed as shown in Diagram 6; and
- subsequently, Mendeley will add citations and references simultaneously in the document.
Chapter 10

According to (Obasola & Mabawonku, 2018)

References


Diagram 6: Inserting a Bibliography or Reference list into a document

1.6 Changing bibliographic output style in Mendeley

To change the bibliographic output style in Mendeley:
- select the ‘View’ tab;
- click on ‘Citation Style’; and
- choose a bibliographic output style from the dropdown list.

In Microsoft Word, under the ‘Reference’ tab, go to ‘Style’ and select the preferred style from the dropdown list.

1.7 Adding the University of Ibadan Manual of Style to Mendeley (UIMS)

The UIMS is unique; it is not included in Mendeley output styles by default. To download the citation link into Mendeley, follow the steps presented in diagrams 7 to 10.

1. Open “Mendeley Desktop”.
2. Under “View”, go to “Citation Style” and click on “More Styles”.
Diagram 7: Adding the University of Ibadan Manual of Style (UIMS) to Mendeley I

3. A new window will open. Click on “Get more Styles”.
Diagram 8: Adding the University of Ibadan Manual of Style (UIMS) to Mendeley II

4. Another window “Get More Styles” will open up.
Diagram 9: Adding the University of Ibadan Manual of Style (UIMS) to Mendeley III

5. Type in the University of Ibadan Manual of Style (UIMS) link: http://csl.mendeley.com/styles/96716661/unibadanManualofStyle-1 into the “Download Style” bar.
(The UIMS link was generated by Olayinka Fatoki and EriifeOluwa Mofoluwawo in 2006)
Diagram 10: Adding the University of Ibadan Manual of Style (UIMS) to Mendeley IV

6. Click on “Download” and then “Done”. The University of Ibadan Style will appear in the list of Citation Styles in your Mendeley Desktop.

Exercise

1. Build a Mendeley library by importing references directly from the following online databases into a Mendeley library.
   i. Medline
   ii. Web of Science
   iii. Google Scholar

2. Create a ‘Watch Folder’ on your computer system and use the folder to build your Mendeley library.

3. Add the following reference type into your Mendeley library manually:
   i. Book
   ii. Journal article
   iii. Thesis
   iv. Newspaper
   v. Report
   vi. Web page
   vii. Television broadcast
Section Two

2.0 Searching Online Academic Databases

This section will guide students and researchers how to search online academic databases in the field of population and public health. The objectives of the section are to:

- introduce students to relevant online academic databases available in population and public health;
- teach students basic strategies for searching online academic databases; and
- teach students how to access online academic databases to ensure publications that will be retrieved from searches are relevant and trustworthy.

2.1 What is an online academic database?

A collection of journals, books, newspapers, etc. produced and published on the Internet by publishers in collaboration with academics. Examples are:

- Medline/Pubmed
- Popline
- WHO Global Health Library
- Global Health (CABI)
- PsycINFO
- Web of Science (Multidisciplinary)
- Scopus (Multidisciplinary)
- Embase etc.

See Table 1 for the list of online academic databases in population and public health.

**Table 1: List of Databases in Population and Public Health**

<table>
<thead>
<tr>
<th>S/N</th>
<th>Name of Database</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PubMed</td>
<td>PubMed is a search service owned by the National Library of Medicine. It provides access to millions of MEDLINE citations and articles up to 1960. The database indexes journals in life sciences. It allows users to access abstracts and full-text articles on journal sites and other relevant resources.</td>
</tr>
<tr>
<td>2</td>
<td>CINAHL</td>
<td>CINAHL is a vital resource containing information resources focusing on nursing and other allied health disciplines.</td>
</tr>
<tr>
<td>3</td>
<td>EMBASE</td>
<td>EMBASE is a biomedical abstract and indexing service with extensive coverage in pharmaceutical research. It is a good supplement to PubMed.</td>
</tr>
<tr>
<td></td>
<td>Database Name</td>
<td>Description</td>
</tr>
<tr>
<td>---</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>4</td>
<td>Cochrane Library</td>
<td>Cochrane Library contains databases that provide robust evidence on which clinical treatment decisions can be based. Its components are Cochrane Reviews (Cochrane Database of Systematic Reviews), Database of Abstracts of Reviews of Effects, Cochrane Central Register of Controlled Trials, Cochrane Methodology Register, Health Technology Assessment Database (HTA), National Health Service (NHS), Economic Evaluation Database and Cochrane Groups (the Cochrane Collaboration).</td>
</tr>
<tr>
<td>5</td>
<td>Popline</td>
<td>Popline is a public health database supported by USAID. It contains scholarly and non-scholarly literature on family planning, population and reproductive health.</td>
</tr>
<tr>
<td>6</td>
<td>TOXNET</td>
<td>TOXNET is a collection of databases containing resources on toxicology, hazardous chemicals, and biohazards.</td>
</tr>
<tr>
<td>7</td>
<td>Trip Pro</td>
<td>Trip is a search service designed to find high-quality research evidence to support clinical practice and care (Evidence-based medicine). The search engine can search concurrently evidence-based sources of systematic reviews, MEDLINE Clinical Queries.</td>
</tr>
<tr>
<td>8</td>
<td>Web of Science</td>
<td>Web of Science is owned by the Institute for Scientific Information (ISI) a division of Thomson Reuters which index current and retrospective multidisciplinary information resources from 1975 upwards. It contains bibliographic records from over 8,500 high impact research journals.</td>
</tr>
<tr>
<td>9</td>
<td>ERIC on EBSCO host</td>
<td>The database is the world's largest education database. It can be used to search for resources on topics in public health that overlaps into the education discipline, including topics like health outreach to college students, substance abuse amongst adolescents in secondary or high school etc.</td>
</tr>
<tr>
<td>10</td>
<td>Psyc INFO</td>
<td>Psyc INFO was produced by the American Psychological Association. It contains resources covering the field of psychology and the psychological aspects of related disciplines, like medicine, psychiatry, nursing, sociology, education, pharmacology, physiology, linguistics, anthropology, business, and law. It is a good database for topics on human behaviours, attitudes, or motivations on specific public health concerns.</td>
</tr>
<tr>
<td>11</td>
<td>Sociological Abstracts (SA)</td>
<td>SA is a database containing information resources covering sociology as well as related disciplines in the social and behavioural sciences.</td>
</tr>
</tbody>
</table>
12 PLOS
https://www.plos.org/
PLOS provides access to an open access service containing materials in science and medicine.

13 WHO Library
https://www.who.int/home or http://kohahq.searo.who.int/
The database provides access to bibliographic details and full text of WHO publications, technical documents, governing body documents, books and reports of NGOs and government agencies and list of periodicals on different health issues around the world especially developing countries.

See the Appendix for a comprehensive list of electronic resources available through the Kenneth Dike Library.

2.2 Using controlled language to search online academic databases

To search an online database, it is important to have a topic of interest or research question.
1. First, decide on a topic of interest or research question.
2. Break the topic or research questions into keywords, phrases (search string), synonyms and alternative spellings. For example, using the title in Figure 1.

Adolescent Mental Health in Nigeria

![The topic has three key words]

Figure 1: Identifying keywords in a research topic

3. Generate synonyms and alternative spellings (See Table 2).

Table 2: Synonyms for the three Keywords

<table>
<thead>
<tr>
<th>Keyword 1</th>
<th>Keyword 2</th>
<th>Keyword 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adolescent</td>
<td>Mental Health</td>
<td>Nigeria</td>
</tr>
<tr>
<td>Teen*(Teens, Teenagers)</td>
<td>Mental*(Mental balance, Mental soundness, Mental condition, Mental state)</td>
<td></td>
</tr>
<tr>
<td>Young*(Young people/person, youngsters, young adults etc.)</td>
<td>Sanity</td>
<td>Nigeria</td>
</tr>
<tr>
<td>Youth</td>
<td>Psychological condition</td>
<td>Nigeria</td>
</tr>
<tr>
<td>Juvenile</td>
<td>Emotional health or Intellectual wellbeing</td>
<td></td>
</tr>
</tbody>
</table>
N.B: Truncating the words with the symbol $ or * will allow the database to capture all relevant material. E.g. “Teen*” will pick up all documents with teens and teenagers.

4. Using the Boolean operators OR, AND or NOT

After identifying the keywords or concept, combine these words using the Boolean operators of OR, AND or NOT.

Table 3: How to use Boolean operators

<table>
<thead>
<tr>
<th>Boolean Operators</th>
<th>Keywords Combination</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>OR</td>
<td>Teen* OR Young*</td>
<td>Using the keywords combination to search will retrieve records containing either term.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Just like the Set Theory in mathematics, the result is like the union of two sets.</td>
</tr>
<tr>
<td>AND</td>
<td>Teens* AND Mental health</td>
<td>This search string will retrieve records containing both search terms.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The intersection of two sets</td>
</tr>
<tr>
<td>NOT</td>
<td>Mental health NOT Maternal health</td>
<td>The search string excludes records containing the second term (Maternal health). Retrieves records containing the first term.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>That is the complement of a set.</td>
</tr>
</tbody>
</table>

5. Selection of relevant academic databases to search

The next step is to select databases that best reflect your subject area or topic of interest. The application of criteria such as scope, quality, searchability and user-friendliness can help in determining the suitability of an online database for literature searches.

6. Criteria for assessing good academic databases

i. Scope: refers to the years covered by the publications in the database, the type of publications, how current are the publications, the relevance of the subject coverage and the suitability of the database for a comprehensive search.

ii. Quality of the database: This refers to the trustworthiness of the content of the database. Articles in good academic databases are peer-reviewed scholarly work.

iii. Searchability: This is the ability of the database to allow controlled vocabulary and citation searching. The search facilities of the database should be suitable for the subject of interest.

iv. User-friendliness: is the ease of use of the database. Will the database allow searches to be refined by date, document type, etc.? Can it link users up with full text? Can it allow the importation of search results from it into a reference manager (Mendeley)?
7. Use of search filters

Most online academic databases have search filters which can be used to limit or refine a search. Filters such as:

- language of publication, e.g. English only;
- publication types, e.g. journal articles, book chapters, magazines, websites etc.;
- year of publication or year range, e.g. 2010, 2005-2010;
- age group, e.g. adult, young people, old people; and
- region or country, e.g. Africa, Europe, Nigeria, Switzerland etc.

2.3 Features of online academic databases

1. Online academic databases are produced with the active involvement of academics.

2. Selection of articles for publication in these databases is based on the objective evaluation of merit, either through peer-review or impact factor.

3. Academic databases allow citation searching to identify papers that have cited key references.

4. These databases offer analysis and evaluation of journals and authors through impact factor and H-index which adds value to published work and recognition for authors.

5. Another important feature is the citation alerts. It helps authors to know who is citing their papers. It is also useful for academic departments for monitoring of research output. It can be used as an indicator of departmental research quality.

6. Academic databases allow the use of wild cards and Boolean operators when searching.

2.4 Searching an online academic database

This section will focus on how to search PubMed Central through HINARI to apply the search strategies in Section 2.3. Start searching PubMed Central via HINARI.

Step 1: Login to HINARI using your institution’s password via [https://www.who.int/hinari/en/](https://www.who.int/hinari/en/) (See your librarian for HINARI’s login details).
Step 2: After logging into HINARI, select a free collection and click on PubMed Central (PMC). See Figure 3.

Step 3: On the PMC interface, type in the keywords of interest in the search box as shown in Figure 4. For example, let’s use the keywords Teen*, Mental health and Nigeria.
Figure 4: Type the keywords in the search box

Searching PubMed Central (PMC) with the keywords Teen*, Mental health, Nigeria using the Boolean operator “AND” gives the result shown in the interface in Figure 5. PMC retrieved over 8000 journal articles from the journal list. The articles retrieved contain the keywords used for searching the list.

Step 4: To further screen the articles retrieved, filters on the left side of the interface can be used for screening the results. The results can be screened by attributes such as the type of article, year of publication or research funder.

Figure 5: Highlighting filters on the PMC interface
Using the three filters, open access, 5 years and NIH reduced the search results to 405 articles. The search will return articles published within the last 5 years, funded by NIH and under the open access license, see Figure 6.

Figure 6: Search results after applying three filters (open access, 5 years and NIH)

The basic strategy used for searching PubMed Central can also be used for other online academic databases. See Diagram 7 for search results from Cochrane Library using a similar search string.
Filters in Cochrane database for refining searches

Figure 7: Search results from the Cochrane Library
Exercise
1. Use the keywords identified in Figure 1 (on page 13) to search the following databases:
   i. WHO Library
   ii. PopLine
   iii. PLOS
Section Three

3.0 An introduction to Turnitin

The objective of this section is to teach users of the manual how to:

- create a class in Turnitin;
- add assignments to your class;
- add students to a class;
- submit assignments from student homepage;
- view students’ submission; and
- interpret Turnitin reports.

3.1 An overview of Turnitin

Turnitin is a cloud-based tool that helps students and instructors guide against plagiarism and similar research misconduct. Submitted works are compared with a vast library of databases from the web, journals, periodicals, academic institutions and a standard repository of previously submitted papers to Turnitin. The software thereafter generates a similarity report which identifies amongst many things the sections of the submitted work that matches another text source in the databases searched. A list of the matching databases, the overall similarity of the submitted work with existing databases, the top databases that have the closest match to the submitted work are also included. To reduce the overall similarity, all instances of a match in the submitted document should be rephrased.

Turnitin is not punitive but aims to develop in its users an appreciation for original scholarly work as well as the skills that are necessary for paraphrasing and reporting of academic contents.

This manual is divided into two parts; the first titled *Instructors’ Setting* that describes how instructors/teachers will create a class and a second titled *Students’ Instructions* that details how students can make submissions.

3.2 Instructor’s Settings

To begin, instructors need to register with Turnitin and create a user profile using their institutional e-mail address (for example, *ab.cdefg@ui.edu.ng*). Students do not need Turnitin subscription but must first be invited by an instructor to join a class.

3.2.1 Creating a class

Instructors can create a new class by following the steps below:

1. When you have successfully logged in, you will be taken to your homepage, also known as the instructor’s homepage (See Figure 8). The instructor’s home page amongst other things contains tabs which can show all the classes you have created (if there are any), certain setting preferences such as the language, help etc.
2. To create a class, click on the ‘add class’ button to the right of the page.
3. This will open a set of text fields with which you can specify the required class settings.
4. Type in the class name of your choice (e.g. GES 301) and an enrolment key will be sent to your students for them to join the class. The enrolment key could be as simple as ‘abcd’.
5. Select the appropriate subject area and student level from the drop-down menu.
6. Specify the class end date after which the class will become inactive.
7. Click submit to create a class and add it to your instructor home page.
8. If you would like students to enrol themselves in this class, they will need both the enrolment key you have chosen and the unique class ID generated by Turnitin.

3.2.2 Adding assignments to your class
Instructors can add various assignments to an existing class by following the steps below.
1. Enter a class by clicking on the class name as listed on your instructor homepage.
2. This will take you to that class homepage.
3. Before you or your students can submit any paper, you will need to add an assignment to this class.
4. Click on the ‘add assignment’ tab.
5. This will open a set of text fields with which you can specify the name of the assignment you are creating (e.g. Feasibility Studies), the dates (and time) students can start sending in their papers and the deadline for submission.
6. Under the optional settings tab, you can provide any additional information to the students as regards the assignment. See the interface in Figure 9 for details on the Postgraduate College settings for thesis plagiarism check.
An Introduction to Reference Management and Plagiarism Checker

Figure 9: The Postgraduate College settings for thesis plagiarism check

7  The instructor can also specify if students can still turn in their assignments after the due date, obtain similarity reports for submissions etc.
8  In addition, the instructor can specify if quotes, bibliographic materials in students’ submissions will be included in the plagiarism check.
9  More importantly, there is a need to indicate if the submissions will be deposited into a repository or not. Turnitin maintains a standard repository of previously submitted documents, against which subsequent submissions will be checked for similarity. Consequently, documents that are work in progress such as draft thesis, manuscripts under
An Introduction to Reference Management and Plagiarism Checker

review etc. should not be deposited into the repository. It is only finished documents such as accepted manuscripts, final thesis copy that should be submitted to the standard repository.

10 Click submit to create the assignment and add it to the class homepage.
11 To add students or view your students list, click the "students" tab above.

3.2.3 Adding students to a class
For students to make submissions to the assignment homepage, the students have to enrol themselves by using the class ID and enrolment key provided by the instructor.

Alternatively, the instructor can add students to the class by following the details below:
1. Click on the ‘students’ tab at the top of the class homepage.
2. You can enrol students to the class by three different methods which can be assessed by the tabs labelled ‘add student’; ‘upload students list’ and ‘e-mail all students’.

Method A
3. If you click on “add student”, a set of text fields will be displayed showing the name of the class the students would be invited to join.
4. Indicate the first name, last name and valid e-mail address of the student.
5. Click on submit to add the student to the class.
6. Repeat steps 1-3 above to add other students as required.

Method B
7. By clicking on the ‘upload students list’ tab, all the students can be added at once by uploading a file that contains the students’ details.
8. The file could be a Plain text, Microsoft Excel or word document and should contain the students’ details in the following order: student’s first name, last name and e-mail address.
9. A properly formatted MS Excel list that can be uploaded will appear as shown below:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Akin</td>
<td>Omoakin</td>
<td><a href="mailto:aomoakin@yahoo.com">aomoakin@yahoo.com</a></td>
</tr>
<tr>
<td>Nneka</td>
<td>Ojie</td>
<td><a href="mailto:nne@yahoo.com">nne@yahoo.com</a></td>
</tr>
</tbody>
</table>

10. To use this second method, click on the “upload students list” tab, then on the browse tab to locate the students’ details file and then click on upload list to add the students to the class.

Method C
11. Thirdly, you can email all the students to join the class.

Whichever method is utilized, students who have a Turnitin subscription will be automatically added while an e-mail containing a link to join the class will be sent to all the invited students who do not have Turnitin subscription.

3.2.4 Viewing students’ submission
1. From your instructor homepage, select a class by clicking on the class name.
2. The class homepage shown in Figure 10 displays a list of the assignments, the start and end dates and an indication of how many students have turned in their submission for each assignment.

3. Click on the “view” link to view the students’ submission for each assignment. This will display a list of all the students enrolled in the class, those who have submitted, their submissions, date submitted and the similarity report for each student’s submission.

4. To view the report for each student, click on the Similarity Report icon in the similarity column which can be found to the immediate right of the paper’s name. A ghosted icon indicates that the Similarity Report has not yet been generated.

![Figure 10: An assignment inbox showing the submissions of three students](image)

3.3 Students’ Instructions

3.3.1 Joining a class and setting up a student’s account

*Students can join a class by following the steps below:*

1. After you have been invited by an instructor, you will receive an e-mail containing the names of the classes you have been invited to join and the instructors who invited you.
2. Click on the “set up account” link in the e-mail. This will take you to the Turnitin account setup page.
3. Input your email address and surname in the appropriate fields and click on the “next” button.
4. To validate your account, a link will be sent to the e-mail address you have just provided.
5. Open the message in your inbox and click on the “create password”. This must be done within 24 hours before the link expires.
6. Clicking on the link will take you to a page where you can provide a password of your choice. The password must be a minimum of eight characters. Click on “create password” after filling the text fields.
An Introduction to Reference Management and Plagiarism Checker

7. You will be notified that account set up is complete.
8. Click on the “Log in” button to take you to your student homepage.

9. Your student homepage will show you the classes you are enrolled in.
10. To enrol in a new class, click on the “enrol in a class” tab at the top of your homepage.

3.3.2 Submitting a paper from your student homepage
1. Click on the appropriate class name. This will take you to the class homepage where you can see all the assignments for this class.
2. To submit an assignment, click on the “submit” button to the right of the assignment name.

![Tumitn](https://example.com/tumitn.png)

**Figure 11:** A student class homepage showing two assignments; feasibility studies and implementation strategies

3. This will take you to a page showing your names, a text field in which you can specify the submission title. A drop-down menu just above your first name provides options for single file upload and cut & paste.
4. With the single file upload option, you can upload a file saved on your computer, in Dropbox or Google drive by clicking on the appropriate link amongst the three.
5. Click on the “upload” button at the bottom of the page
6. Wait for a few minutes (depending on the size of the uploaded document) after which a preview of the document you are trying to upload will be generated.
7. Finish the submission by clicking on the “confirm” button at the bottom of the page.
8. Your submission will be confirmed and a digital receipt of it will be generated which you can print out if you wish. You can return to the assignment inbox or upload another file by clicking on the appropriate buttons at the bottom of the page.

3.3.3 Viewing the similarity report for your submission

1. Go to the assignment inbox. This will show a list of submitted papers and their similarity reports.
2. To view the similarity report of a paper, click on the Similarity Report icon in the similarity column which can be found to the immediate right of the paper’s name. A ghosted icon indicates that the Similarity Report has not yet been generated.
3. The similarity report will be open in a new browser window called the document viewer. See figure 12 for a detailed view of the Turnitin document viewer.

3.4 Interpreting a similarity report

Figure 12: A typical document viewer is reproduced below

1. The document viewer will show the contents of the paper and a sidebar to the right.
2. Texts of the submitted document that show no variation in exact wording with databases (this is called a match) are highlighted, colour-coded and tagged with a match flag.
3. All the match flags are numbered. Clicking on a match flag will open the database (original source).
An Introduction to Reference Management and Plagiarism Checker

4. The sidebar contains the top sources which are the databases that have the closest match to the submitted document text.
5. The sidebar also contains a match overview—a percentage indication of the overall similarity of the paper to databases. To reduce the overall similarity, all instances of a match in the submitted document should be rephrased.
6. Click on the “list of all sources” in the side bar to see a list of all matching databases and the percentage amount each contributes to the overall similarity of your report.
7. Click on the “filter and settings” button to exclude quotes, bibliography, sources that are less than a specified number of words or percentage.
8. Click on the download button. It will provide options to download the current view (i.e. a PDF file format of the similarity report), digital receipt of the submission or the originally submitted file.

Exercises
1. Create a class and enrol 5 students into the class.
2. How do you view a students’ submission?
3. Describe the important steps in interpreting a similarity report.

Conclusion
This manual provides foundational knowledge in online literature searching, reference management and the use of Turnitin to assess plagiarism. It was reviewed and tested through workshop sessions with librarians and graduate students at the University of Ibadan. There remains a great deal that students need to learn to advance their knowledge and skill as this is just an introduction into the three areas. Hence, students who need further assistance or personal tutorials can contact the Systems Unit at the Kenneth Dike Library, University of Ibadan or the E. Latunde Odeku Medical Library, College.
Appendix
List of Available Electronic Resources available through Kenneth Dike Library

<table>
<thead>
<tr>
<th>S/No</th>
<th>Electronic Resources</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PROQUEST</td>
<td>All Subject Areas</td>
</tr>
<tr>
<td></td>
<td>URL:</td>
<td>search.proquest.com</td>
</tr>
<tr>
<td></td>
<td>Access: IP-regulated</td>
<td></td>
</tr>
<tr>
<td></td>
<td>URL:</td>
<td><a href="http://emeraldinsight.com">http://emeraldinsight.com</a></td>
</tr>
<tr>
<td></td>
<td>Access: IP-regulated</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>JAYPEE</td>
<td>EBOOK</td>
</tr>
<tr>
<td></td>
<td>URL:</td>
<td>Jaypeedigital.com</td>
</tr>
<tr>
<td></td>
<td>Access: IP-regulated</td>
<td></td>
</tr>
<tr>
<td></td>
<td>URL:</td>
<td>link.springer.com</td>
</tr>
<tr>
<td></td>
<td>Access: IP-regulated</td>
<td></td>
</tr>
</tbody>
</table>
**An Introduction to Reference Management and Plagiarism Checker**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td><strong>JSTOR</strong>&lt;br&gt;URL: <a href="http://www.jstor.org/">http://www.jstor.org/</a>&lt;br&gt;Access: IP-regulated &amp; individual registration required</td>
</tr>
<tr>
<td>7</td>
<td><strong>BIOONE</strong>&lt;br&gt;<a href="http://www.bioone.org">www.bioone.org</a></td>
</tr>
<tr>
<td>8</td>
<td><strong>Nature Journals</strong>&lt;br&gt;<a href="http://www.nature.com">www.nature.com</a></td>
</tr>
<tr>
<td>10</td>
<td><strong>Royal Society Journals Collection</strong>&lt;br&gt;<a href="http://royalsocietypublishing.org">http://royalsocietypublishing.org</a></td>
</tr>
<tr>
<td>11</td>
<td><strong>DOAJ</strong>&lt;br&gt;<a href="http://www.doaj.org">http://www.doaj.org</a></td>
</tr>
<tr>
<td></td>
<td><strong>An Introduction to Reference Management and Plagiarism Checker</strong></td>
</tr>
<tr>
<td>---</td>
<td>---------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 13 | **BOOKBOON**  
http://www.bookboon.com  
Open Access | Free access E-Book |
| 14 | **African Journals Online**  
http://www.ajol.info/  
Open Access | African Journal Online (AJOL) is a service to provide access to African published research and increase worldwide knowledge of indigenous scholarship. |
| 15 | **BIOMED CENTRAL**  
http://www.biomedcentral.com  
Open Access | Biomed central is a publisher of more than 150 peer-reviewed open access journals. |
| 16 | **BMJ Publishing Group**  
http://www.bmjournals.com/subscriptions/countries.shtml  
Open Access | BMJ Group publishes BMJ (British medical Journal), a number of journals covering major medical Specialties and a growing number of online and events products for the healthcare profession. |
| 17 | **POPLINE**  
http://www.popline.org  
Open Access | POPLINE® (Population Information online), the world’s largest databases on reproductive health. |
| 18 | **Free Pdf**  
http://www.freefullpdf.com  
Open Access | Covers all subject areas |
| 19 | **World Bank Group**  
http://www.worldbank.org  
Open Access | |
| 20 | **E-JOURNALS**  
http://www.e-journals.org  
Open Access | E-journals are part of the World Wide Virtual library. Provides links to world electronic journals. |
### An Introduction to Reference Management and Plagiarism Checker

<table>
<thead>
<tr>
<th>21</th>
<th>INTECH</th>
<th>All Subject areas especially Sciences</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><a href="http://www.intechopen.com/">http://www.intechopen.com/</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Open Access</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>22</th>
<th>ERIC</th>
<th>ERIC (Education Resources Information Centre) is a comprehensive database containing abstracts of journals articles, reports, curriculum guides, conference proceedings, etc. It covers all areas of education at all ages and grade levels. ERIC Documents 1993+ is now freely available online.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><a href="http://eric.ed.gov/">http://eric.ed.gov/</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Open Access</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>23</th>
<th>SAGE</th>
<th>SAGE is a leading international provider of innovative, high-quality content publishing more than 1000 journals and over 800 new books each year, spanning a wide range of subject areas.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>24</th>
<th>Z-Library</th>
<th>Covers a wide range of subject areas. Users can download 10 books or more daily.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Open Access</td>
<td></td>
</tr>
</tbody>
</table>

**NB:** IP Regulated- implies user must be on the University Network to have access. For further enquiries on the e-resources contact, eresources@library.ui.edu.ng

### Bibliography

https://www.elsevier.com/solutions/embase-biomedical-research
https://www.cochranelibrary.com/
https://nigeria.cochrane.org/
https://www.popline.org/
https://toxnet.nlm.nih.gov/
https://www.trippro.com/tour.html
https://www.turnitin.com